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1 INTRODUCTION 
This document describes the installation and use of the following Digigram multichannel PCI Express 
cards under Windows: ALP280e, and ALP280e-MIC. 

These cards are part of the ALP-X professional sound cards range. 

 

 

 

 

 

 

  

 

 

 

Copyright 2025 Digigram. All rights reserved. 

No part of this manual may be reproduced without the prior consent of Digigram. This reservation includes 
photocopying, translating and/or reformatting the information contained in this manual. 

Everything possible has been done to ensure the greatest accuracy, however Diagram cannot be held liable 
for any error or omission and reserves the right to make modifications and improvements without prior 
notice. 

Digigram and the Digigram logo, ALP280e and ALP280e-MIC are trademarks or brand names of Digigram 
Digital. All other marks are owned by their respective companies.  
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2 IMPORTANT NOTICE 
Certifications 
The product is currently being certified.  

This product has been designed in accordance with the following standards: 

●​ EMC Directive 2014/30/EU. 
●​ FCC Rules Part 15, Subpart B. 

 

To ensure compliance with the standards listed above, the following rules must be followed: 

●​ The cable supplied must not be modified. 
●​ The additional cables used must have their respective shielding connected at each end. 

 

Caution 
An electrostatic discharge (ESD) can damage the card components. Take the 
following precautions to avoid such damage when handling the card: 

Connect the card and everything entering into contact with it to the earth potential by providing a 
conductive surface and discharge paths. Take these precautions as a minimum: 

●​ Unplug all power and signal sources. 
●​ Place the card on an earthed conductive work surface. 
●​ Connect to the earth potential using an anti-static strap or by holding an earthed object. 
●​ Earth all the tools entering into contact with the card. 

 

 

Given the shortened length of the PCI EXPRESSTM connector and the resulting lack of 
mechanical stability, we strongly advise against transporting the cards installed in a 
computer, unless its chassis or case has a device for holding the card firmly in place to avoid 
material damage. 
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3 BOX CONTENTS 
Thank you for purchasing a DIGIGRAM sound card in the ALP-X range. 

The box contains: 

●​ The ALP280e or ALP280e-MIC sound card equipped with a low-profile bracket (79.2 mm), 
●​ a standard height bracket (full height: 120 mm) that can be fitted instead of the low profile 

one. 
 

The two breakout cables that bear the XLR and BNC connectors are available as an option. One 
cable supports the analog I/Os, the other one supports the GPIOs and external clocks.  

Please contact your card supplier to acquire the Digigram-certified cables. 

 
 

 

4 GENERAL CHARACTERISTICS 
ALP280e and ALP280e-MIC are PCI EXPRESSTM x1 sound cards. They can be inserted into and 
therefore operate in PCIe® x1, x4, x8 or x16 slots.  

4.1 Main hardware characteristics 
 

●​ 8 balanced analog inputs with:​
- software-adjustable analog gain and a maximum input line level of +24 dBu, and a 
maximum input mic level of +10 dBu  (ALP280e-MIC)​
- switchable 48V phantom power on each input (ALP280e-MIC)​
These inputs can be used in unbalanced mode (“-” signal to be connected to the ground). 

●​ 2 electronically balanced analog outputs, with a maximum output level of +24 dBu. 
(Electronically balanced outputs can process either balanced or unbalanced lines without 
loss of level). 

●​ 1 word clock input/output (up to 192 kHz) 
●​ 1 AES11 sync input (up to 192 kHz) 
●​ 8 GPI dry contacts and 8 GPO relays 
●​ Inter-card synchronisation 

 

4.2 Main software characteristics  
●​ Low latency multi-card drivers​

- Wasapi/DirectSound and ASIO application programming interfaces under Windows 
●​ 8 playback channels / 8 recording channels 
●​ Simultaneous acquisition and playback in PCM (8, 16 and 24 bit)  
●​ On-board mixing of physical audio inputs and software "playback" devices to physical audio 

outputs and software recording devices. 
●​ "ALP-X Manager" application installed with the driver, to control the card settings:​

- clock source (internal, wordclock, AES11)​
- frequency of the fallback internal clock​
- input and output gains and  VU-meters​
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- 48V phantom power switches (for -MIC cards)​
- routing of inputs to outputs​
- GPIOs 

●​ API for implementing the management of the card settings in a software application. 

 

4.3 Routing audio streams in the card 
The ALP cards incorporate an on-board mixer in an FPGA component.  
 
On ALP280e and ALP280e-MIC, this is a mixer with 16 mono inputs and 10 mono outputs. The 
mixer captures the 8 analog input channels of the card and the 8 channels from the software 
playback devices. 
The mixer restores 10 audio channels, respectively to the 2 physical analog outputs of the card 
and the 8 software recording device channels.​
The mixer can therefore be configured to perform the mixing and the routing of the 16 input 
channels to the 10 output channels (10 mix sums). 
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The following diagrams show a more detailed view of the workflows in the card, with the input 
and output gains. 

 
 

 

5 REQUIRED CONFIGURATION 

5.1 Required hardware configuration 
There are no particular hardware restrictions in terms of PC on using the ALP card and its driver. The 
PC can have standard height or low profile PCIe card slots. The ALP card can in particular be used in 
2U racks or reduced size PCs by using the smaller bracket instead of the standard height bracket 
that is fitted by default.  

A PCI EXPRESSTM (PCIe®) x1, x4, x8 or x16 slot must be available to plug in the card. 

The processor power and memory required depend mainly on the operating system and the 
applications used on the PC. 

 

Note: The driver of the card reports to the OS that it does not manage the Sleep mode.  As a 
consequence, the PC should not go to sleep mode. 
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In case the PC goes to sleep mode under Windows, please proceed as follows to disable the sleep 
mode. 

 

The windows sleep mode for the PCIe bus must be disabled.  

Go to Windows Settings, System, and select “Power & sleep”. 

Select Never” for the option “Put the computer to sleep”. 

 

On the same window, click on “Additional power settings”. 

 

 

Click on “Change plan settings” in 
front of “Balanced 
(recommended)” 

 

Select “Change advanced power 
settings”. 
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Select “PCI Express”, “Link State 
Power Management”, and select 
“Off” for the setting. 

Click on Ok to validate 
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5.2 Necessary software configuration under Windows 
ALP cards operate under Windows from 64-bit versions of Windows 10 (from version 20H2), and 
under Windows Server from version 2019.​
​
To use your ALP-X card, you must install the driver included in the installation kit “ALP-X Kit”. 
Download the latest version from the Digigram website from the support page of any ALP card (the 
same diver supports all the ALP cards).​
 ​
The "ALP-X Kit" installer is used to install the following components:  

●​ a 64-bit WDM driver offering the WASAPI and DirectSound application interfaces, 
●​ an ASIO driver (32 bits and 64 bits), with its "ALP-X ASIO Settings" configuration interface. 

Installing this component is optional, 
●​ the "ALP-X Manager" application, which serves to adjust the ALP-X card settings and display 

the vu-meters. Installing this component is optional. 

 

Note for Windows Server operating systems ​
Under Windows server, it is necessary to allow the applications to access the input audio 

devices of the sound cards.​
Please proceed as follows: 

●​ Go to the Windows Settings, and select Privacy. 
●​ Select “Microphone” 
●​ Activate the option “Allow apps to access your microphone” 

 

 

6 HARDWARE INSTALLATION 
Given the shortened length of the PCI EXPRESSTM connector and the resulting lack of mechanical 
stability, we strongly advise against transporting the cards installed in a computer, unless it has a 
device for holding the card firmly in place to avoid material damage. 

The card must be inserted in the computer before installing its driver. 

6.1 Preparing the card 
Before fixing the card in the computer, make sure you install on the card the bracket matching the 
PCIe slot into which it is going to be inserted. ​
To install the card in a standard height PCIe slot, remove the low profile bracket by loosening the 
two screws on the sides of the cable connector, position the standard height bracket and retighten 
the two screws. 
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6.2 Installing the card 
Insert the card in the available PCIe slot and press to position it firmly.  
Tighten the screw fixing the bracket to the chassis or lock the card using the device provided for this 
purpose on your computer. 

6.3 State of internal LED 
The ALP card has two internal LEDs on the edge of its mother board, as shown below. The state of 
these LEDs can be seen when the PC cover is open. 

 

If the card and its on-board firmware are initialised correctly, LED 1 must be lit solid green, and LED 
2 must flash every second (1 Hz).​
If LED 2 flashes faster (twice per second - 2 Hz), this means that the firmware version that has been 
uploaded to the card is corrupted, and the card is running the backup factory firmware version. It is 
then necessary to re-install the appropriate firmware version. 

7 SOFTWARE INSTALLATION UNDER WINDOWS 
IMPORTANT 

To install the software, you must have administrator rights on the computer. 

 

Please visit the Digigram website at www.digigram.com to obtain the most recent driver. 

Should you use a specific application developed or installed by a Digigram partner, this may mean 
using a specific driver version. In this case, confirm with your application supplier which driver 
version to use. 
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Any driver downloaded from our website has to be unpacked before installing it. Double click on the 
downloaded file to start the auto-extraction utility. You can choose the default destination 
(temporary Windows folder) or select another one. 

7.1 Very first installation 
●​ Switch off the computer and insert the ALP card(s) in an available PCIe slot. 
●​ Restart the computer. 
●​ Click on Cancel if the "New device detected" wizard appears. 
●​ Double click on the ALP driver installation file  "ALP-X Kit vxx.exe" 

 

Click on Next to continue with the 
installation. 

 Click on "I agree” to continue with the 
installation. 

 

In this window, select the components to be 
installed in addition to the card driver. 

●​ ALP-X Manager: application used to 
configure the settings of the ALP card(s) 
installed. ​
Some software programs may have been 
designed with the ALP card settings 
controls built in. In this case, it may be 
recommended not to install the ALP-X 
Manager application. 

●​ ALP-X ASIO Settings: this application is 
used to configure the ASIO driver 
settings. There is no need to install it if 
no application reliant on the ASIO 
interface is used.  
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The driver is installed by default in the folder 
"C:\Program Files (x86)\Digigram\ALP-X".  

To change this folder, click on Browse and 
select a new destination. 

Click on Install to continue with the 
installation. 

 

 

The driver and selected components are 
being installed. 

 

 

7.2 Updating the driver version 
If a driver version for the ALP card has already been installed, and you want to install another 
version, first uninstall the current driver version (see chapter “Uninstalling the driver under 
Windows”), and then install the new version by double clicking on the driver installation file  "ALP-X 
Kit vxx.exe" (see the detailed procedure in the hereinabove chapter “Very first installation”). 

 

7.3 Updating the firmware 
The ALP card on-board firmware may have to be upgraded, and updates can be supplied by 
Digigram and prove necessary. 

Updating the firmware can be done from the ALP-X Manager GUI (see chapter Firmware update 
procedure). 

-​  

7.4 Verifying the card installation 
Once the driver and card have been installed as per the process described hereinabove, you can 
verify that the card is installed correctly and working properly. 
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7.4.1 Presence of playback and recording  devices 
The audio devices exposed by the card driver are visible on the Windows Sound panel. To open it, 
right click on the loudspeaker icon in the Windows taskbar and select "Sounds": 

 . 

The audio devices exposed by the card driver are visible from the "Play" and "Record" tabs. 
​

 
If the card devices are not listed in the Windows Sound control panel: 

●​ Make sure that the card is inserted correctly in the PCI slot and screwed to the computer 
chassis. 

●​ Try to uninstall the ALP-X Kit (from the Windows control panel, Applications) and re-install it. 

Playback to a device can be tested by right clicking on it and selecting "Test". The VU-meter must 
then show modulation and the sound must be heard on the card output(s) according to the 
routing and levels configured in the ALP-X Manager application. 

 
If several cards of the same model are installed, their devices have the same name (ALP PLAY 
and ALP REC), but the name of the card associated to each device differs from an index (no 
index for the first card, and index starting from 2 for the following cards of the same model). 
In the example below, the first card in the PCIe slot enumeration order is an ALP280e, the 
second card is an ALP442e, and the third card is an ALP882e. ​
 

First card: ALP280e Second card: ALP442e Third card: ALP882e 

ALP PLAY 1-2 ​
Digigram ALP280e​
ALP PLAY 3-4 ​
Digigram ALP280e 
... 
ALP PLAY 7-8 ​
Digigram ALP280e 

ALP PLAY 1-2 ​
Digigram ALP442e​
ALP PLAY 3-4 ​
Digigram ALP442e 
... 
ALP PLAY 7-8 ​
Digigram ALP442e 

ALP PLAY 1-2 ​
2-Digigram ALP882e​
ALP PLAY 3-4 ​
2-Digigram ALP882e 
... 
ALP PLAY 15-16 ​
2-DigigramALP882e  

Note 
The output WDM device level setting, accessible from the Windows Sound control panel, is 
coupled to the corresponding input level setting of the card's onboard mixer, and impacts left 
and right channels.​
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Note that after the first installation of the card, the default gain settings are as follows: 
●​ Input analog gains are set to -24 dB (+24 dU -> 0 dBfs). 
●​ Digital input and output gains are set to 0 dB 

 

7.4.2 Card detected by the Digigram ALP-X Manager 
application 
 
The ALP-X Manager application, installed with the driver, is used to control the ALP card settings via 
a graphic interface. This application can be launched from the shortcut created on the desktop or 
from the start menu, Digigram group. The card must appear as below if it and its driver are installed 
correctly. Note that a maximum of eight ALP cards can be displayed and handled in ALP-X Manager. 

 

​
 

Note: When the ALP Manager application is started, if the driver detects that the firmware version 
on the ALP Card is too old, a message like the following one is displayed. ​

  

If several ALP cards are running in the PC with a too old firmware version, one message per card is 
displayed. 
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From the list of ALP cards displayed in the ALP Manager, a firmware to be updated is displayed in 
red colour as shown below.​

 

Please refer to the firmware update procedure. 

 

7.4.3 Card availability under ASIO 
If the ASIO driver for the card has been installed (option to be selected during the installation 
procedure), then the card must be detected and displayed in the ASIO control panel.​
This control panel can be started from the ASIO application to select the appropriate audio devices. 
All cards present must be listed in the "ACTIVE CARDS GROUP" selection list.​
 
 

7.5 Adjusting the internal latency of the card 

The following describes advanced settings that may impact the proper functioning of data 
exchanges between the card and the PC.  It is recommended that you do not change these settings.  

The internal latency of the card is determined by the duration of sample buffers the card exchanges 
with the PC for playback and recording audio streams. By default, this duration is 512 sampling clock 
periods (10.7ms at 48 kHz).​
The lower the internal latency, the lower the global latency of the card. However, a very low latency 
may lead to “choppy” audio on slow PCs. In this case it is necessary to increase the internal latency. 

The internal latency of the card can be changed by electing the properties of the card, from the 
Windows Device Manager: 

 

Right click on the ALP card, and select Properties, Advanced. The following window is displayed: 
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With audio processing timelog:​
This option is to be used only for debugging purposes 
(debugview). Do not activate it unless requested by 
Digigram technical support. 
 
Stats: These displayed values are only for technical 
investigation purposes. 
 
Buffer size: size of the buffers exchanged between the card 
and the driver. The size is expressed in samples (ex: at 48 
kHz, a value of 48 corresponds to 1ms buffer).​
Values are from 8 samples to 192 samples.​
It impacts the driver latency. 
 
Record buffers: Number of internal buffers used for 
recording (from 2 to 20 buffers). 
 
Playbackbuffers: Number of internal buffers used for 
playback (from 2 to 20 buffers). 
 
Note: in case breaks in the audio flow are experienced, it is 
necessary to test other parameter values (number of buffers, 
size of buffers). 
 

 

Select the new latency value, and click on “Ok”. 

The PC must be restarted. 

 

7.6 Replacing a card 
If an ALP card has to be replaced by another one, it is strongly recommended to proceed as follows: 

●​ Turn off the PC. 
●​ Remove the card to be replaced. 
●​ Restart the PC. 
●​ Go to the Windows Device Manager, and select “Sound, video and game controllers”.​

From the “View” menu, select “Show hidden devices”.​
Select the ALP card that was hidden and select “Uninstall”. 

●​  Turn off the PC. 
●​ Insert the new card. 
●​ Restart the PC. 

7.7 Changing the order of installed cards 
If several ALP cards are installed, and you want to move cards from one slot to another, it is strongly 
recommended to proceed as follows: 

●​ Turn off the PC. 
●​ Remove the cards to be moved. 
●​ Restart the PC. 
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●​ Go to the Windows Device Manager, and select “Sound, video and game controllers”.​
From the “View” menu, select “Show hidden devices”.​
Select the ALP cards that were hidden and select “Uninstall”. 

●​  Turn off the PC.  
●​ Insert the cards in the appropriate slots. 
●​ Restart the PC. 

 

8 UNINSTALLING THE DRIVER UNDER 
WINDOWS 
Proceed as follows to uninstall an ALP driver version. 

Please note that uninstalling a version must be done prior to the installation of another version. 

 

 
From Windows Start menu, open the ”Settings” panel 

 

Click on the “Apps” icon. 

 

From the list of installed Apps & features, select ALP-X Kit. 

 

Click on Uninstall. 

This will remove all the ALP-X ... components 
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9 CONFIGURING THE CARD UNDER WINDOWS 
VIA THE ALP-X MANAGER APPLICATION 
This application can be launched from the shortcut created on the desktop or from the start menu, 
Digigram group. 

 

When the ALP Manager application is started, if the driver detects that the firmware version on the 
ALP Card is too old, a message like the following one is displayed. ​

  

If several ALP cards are running in the PC with a too old firmware version, one message per card is 
displayed. 

From the list of ALP cards displayed in the ALP Manager, a firmware to be updated is displayed in 
red colour as shown below.​

 

Please refer to the firmware update procedure. 

 

If another view is displayed, click on the card icon   to display the list of ALP cards present 
and detected. 

The following settings are displayed for each ALP card detected: 

●​ its serial number, 
●​ the on-board firmware version, 
●​ the size of buffers exchanged between the driver and the card (see Adjusting the internal 

latency of the card). 
 

9.1 Sampling clock management 
Click on the clock icon to display the clock selection settings of each present ALP card. 
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The ALP card can be configured as an internal clock or external 
clock (AES11 Sync, Word Clock). ​
To select the clock source, click on the "Prioritized source" 
selection list and select the desired source. 

A red padlock icon on the right of the clock name means the 
clock signal is absent. A green padlock icon on the right of the 
clock name means the clock signal is present. 

In addition, the detected sample rate of an external clock is 
displayed in the clock list. 

 

 

If the internal clock is selected (“Internal”), select the sampling 
Rate value from the “Internal Sampling Rate” selection list.  

Possible values are: (in kHz)11.025, 16, 22.05, 24, 32, 44.1, 48, 64, 
88.2, 96, 128, 176.4, 192, and Application. 

Selecting “Application” means that the sampling frequency is set 
by the application. 

Setting the card to one of the frequency values means that a 
software application that uses the card must be configured at 
the same frequency value. 

 

If an external clock is selected, the card is synchronised to it as 
long as it is present.  

If the external clock signal is lost, the ALP card falls back to its 
internal clock, which is automatically set at the same frequency 
as the external clock. 

 

The clock source used at a given moment is displayed in the 
"Sync Source" field, and its frequency value is given by the 
"Sampling Rate" field. 
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9.2 Managing input and output levels 
At the first installation of the card, the default gain settings are as follows: 

●​ Input analog gains are set to -24 dB (+24 dU -> 0 dBfs). 
●​ Digital input and output gains are set to 0 dB 
●​ The routing matrix is configured this way:​

 

Play 1-2 routed to analog outputs 1-2​
Play 3-4 routed to analog outputs 1-2​
Play 5-6 routed to analog outputs 1-2​
Play 7-8 routed to analog outputs 1-2 

Analog Inputs 1-2 routed to Rec channels 1-2​
Analog Inputs 3-4 routed to Rec channels 3-4 
Analog Inputs 5-6 routed to Rec channels 5-6​
Analog Inputs 7-8 routed to Rec channels 7-8 

The other routing points of the matrix are muted (no mix).​

 
 

Click on the  icon to access the "I/O Monitor" view which is used to adjust audio levels. 

 

The onboard mixer features two categories of audio inputs and audio outputs 

●​ Software playback inputs.  They correspond to the playback devices exposed by the driver to 
the applications. 

●​ Physical inputs  (analog)  
●​ Physical outputs (analog)  
●​ Software recording outputs.  They correspond to the recording devices exposed by the 

driver and captured by the applications 
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The table below gives the correspondence between the sound devices exposed in the operating 
system and the Play inputs and Rec outputs of the matrix.  
 

Software audio device Windows 
Audio 

Devices 

ASIO 
devices 

 Software audio device Windows 
Audio 

Devices 

ASIO 
devices 

Playback devices = Mixer inputs   Recording devices = Mixer output 

PLAY 1-2 (stereo)​
PLAY 1 & PLAY 2 (mono) 

ALP PLAY 1-2 ALP-1 / 
ALP-2 

 REC 1-2 (stereo)​
REC 1 & REC 2 (mono) 

ALP REC 1-2 ALP-1 / 
ALP-2 

PLAY 3-4 (stereo)​
PLAY 3 & PLAY 4 (mono) 

ALP PLAY 3-4 ALP-3 / 
ALP-4 

 REC 3-4 (stereo)​
REC 3 & REC 4 (mono) 

ALP REC 3-4 ALP-3 / 
ALP-4 

PLAY 5-6 (stereo)​
PLAY 5 & PLAY 6 (mono) 

ALP PLAY 5-6 ALP-5 / 
ALP-6 

 PLAY 5-6 (stereo)​
REC 5 & REC 6 (mono) 

ALP REC 5-6 ALP-5 / 
ALP-6 

PLAY 7-8 (stereo)​
PLAY 7 & PLAY 8 (mono) 

ALP PLAY 7-8 ALP-7 / 
ALP-8 

 REC 7-8 (stereo)​
REC 7 & REC 8 (mono) 

ALP REC 7-8 ALP-7 / 
ALP-8 

 

The physical inputs are displayed in the mixer GUI when the "INPUTS" vertical button is activated. 
The software playback inputs are displayed when the "PLAYBACK" vertical button is activated.​
The physical outputs are displayed when the "OUTPUTS" vertical button is activated.​
The software recording inputs are displayed when the "RECORD"vertical  button is activated. 

 
From the bottom bar of the I/O Monitor view, select the ALP card to display its Monitor page. 

 

The following table lists the various possible settings from the mixer view. 

 
Click on this icon to display the concerned pair of channels as two mono 
channel strips. 

 
Click on this icon to display the concerned pair of channels as one stereo 
channel strip. 

On a stereo channel strip, the controls (volumes, solo, mute) are applied 
to the left and right channels. 

 

Channel strip name 

Click on the channel strip name and enter a new name. 

Note: when a channel strip display is changed from mono to stereo, or 
stereo to mono, the channel stream name goes back to the default name. 

As a consequence, it is recommended to keep the display mode used 
(mono or stereo) when the channel strip names have been changed. 
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Analog input gain settings 

The first screen capture on the left relates to the ALP280e. The screen 
capture below relates to the ALP280e-MIC, where a Line/Mic level 
selection is available.  

The analog input gain can be adjusted thanks to the potentiometer at the 
top of the analog input channel strip. Note that if the inputs are displayed 
as a stereo input, the gain adjustment applies to the left and right 
channels. 

There are three ways of adjusting the input gain. 

1)​ Click on the round potentiometer without releasing and move the 
mouse left or right to decrease and increase the gain respectively, in 
steps of 0.5 dB. 

2)​ Press the Ctrl key without releasing and then click on the 
potentiometer with the mouse. The gain can be adjusted in steps of 1 
dB with the mouse wheel as long as the Ctrl key remains pressed. 

3)​ Click on the gain value displayed below the potentiometer, write and 
enter the new value. 

Double click on the potentiometer to reset the analog gain to 0 dB. 

For ALP280e and ALP280e-MIC in LINE input mode, analog input gain 
values range from -24 dB to +16 dB, in steps of 0.5 dB. 

Selecting the Mic mode from the Line/Mic selector sets the input to the 
Mic mode. This changes the gain range and gives access to the 48V 
phantom power switch. 

For ALP280e-MIC in Mic input mode, analog input gain values range from 0 
dB to +56 dB, in steps of 0.5 dB. 

Here are a few examples of input level alignment: 

ALP280e and  ALP280e-MIC in 
LINE input mode 

ALP280e-MIC in Mic input mode 

Gain=+16dB: -16 dBu->0 dBfs. ​
Gain=+ 10 dB: -10 dBu->0 dBfs           
Gain=+ 0 dB: 0 dBu->0 dBfs   ​
Gain=-10 dB: +10 dBu->0 dBfs​
Gain=-24 dB: +24 dBu->-0 dBfs 

Gain= 56 dB: -56 dBu->0 dBfs​
Gain=  46 dB: -46 dBu-> 0dBfs​
Gain=  30 dB: -30 dBu-> 0dBfs   ​
Gain= 10  dB: -10 dBu->0 dBfs        ​
Gain=  0 dB: 0 dBu->0 dBfs​
Gapain=  -10 dB: +10 dBu->0 dBfs 
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Digital gain settings 

Digital gains are available for all the input and output audio streams, and 
can be adjusted via the faders. 

There are three ways of adjusting the digital gain. 

1)​ Click and hold the fader button down and move the mouse vertically 
to increase/decrease the gain in 0.1 dB steps.  

2)​ Press the Ctrl key without releasing and then click on the fader 
button. The gain can be adjusted with the mouse wheel in 1 dB steps 
as long as the Ctrl key remains pressed. 

3)​ Click on the gain value displayed below the fader, write and enter the 
new value. 

Double click on the fader to reset the digital gain to 0 dB.​
Digital gain values range from -90.1 dB to +12 dB, in steps of 0.1 dB. 

 

Each Vu-meter displays the input signal level in dBfs, before or after the 
digital gain is applied..​
Double click on the blue radio button on the bottom left of the vu-meter 
to display the Pre/Post digital gain selection.  The radio button appearance 
depends on the selected mode 

: Pre-fader                        : Post-fader 

 

The Vu-meters display the levels in peak-meter. 

The clipping threshold of the vu-meters can be adjusted from the global 
menu “Settings/Audio meters” . When the signal level exceeds this 
threshold, the red LED above the Vu-meter lights up. 

 

48V phantom power 

Setting the phantom power on an analog input is possible when this input 
is set to Mic level mode. 

 
Solo​
The solo button has an effect on the two channels of a stereo pair. 

A click on this button sets the two channels in solo mode, and it turns 
yellow. 

 
Mute 

The mute button has an effect on the two channels of a stereo pair. 

A click on this button sets the two channels in mute mode, and it turns 
red. 
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 Pairing channel strips 

To set a common level for several input channel strips, validate the button 
on each channel strip. The gain setting on one channel strip is then 
applied to all the paired channel strips. 

 

Pre or post fader Vu-meters 

The blue LED button allows selecting if the Vu-meter displays the signal 
level before or after the digital gain set via the fader. 

To select pre or post fader Vu-meter, click on the blue LED button on the 
right of the Vu-meter bar(s), and select the mode. 
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9.3 Managing the routing and mixing of input signals  

 

Click on the  icon to access the "Matrix" view which is used to mix/route input signals towards 
the outputs 

 

From the bottom bar of the MATRIX view, select the ALP card to display its matrix. 

 

For each ALP card, the internal mixer can mix all or some of the input signals towards each output. 
Each output can therefore receive its own mix of inputs. 

As in the "I/O Monitor" view, it is possible to select the inputs displayed in this matrix (physical 
inputs-INPUTS and/or software play inputs-PLAYBACK) and the outputs displayed (physical 
outputs-OUTPUTS and/or outputs-RECORD). 

There are two possible matrix views: 

●​ A complete view that shows all the mixing points (screen capture here-above). This view is 
displayed when the "MATRIX MODE" selector is positioned on "ADVANCED" (view displayed 
above). 

●​ A reduced view which displays a sub-assembly of mixing points (screen capture here-below). 
This view is displayed when the "MATRIX MODE" selector is positioned on "REDUCED" 
(below).​
It allows to route left input channels of the matrix to its left output channels, and the right 
input channels to its right output channels​
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​
 

Each mixing point can be activated or deactivated by clicking on it (Mute / Unmute). All the hidden 
boxes are deactivated mixing points. 

The digital gain applied to the channel can be adjusted for each mixing point. To do this, press the 
Ctrl key, place the mouse cursor over the mixing point without clicking and use the mouse wheel to 
increase or decrease the digital gain value; the gain value applied is then displayed during the 
adjustment.​
To directly set the gain to 0dB,  press the Ctrl key and double click on the mixing point.​
Visually, a mixing point is a solid blue if the gain is at its maximum (+12 dB). It is circled in blue and 
empty if the gain is at its minimum value (-90 dB). 

 

Caution:  

 

Moving from "ADVANCED" view to "REDUCED" view 
deactivates certain mixing points. If gain settings have been 
configured on these points in the "ADVANCED" view, these 
settings are lost when moving to "REDUCED" mode. The 
message opposite warns the user. Select Yes to confirm the 
move to REDUCED mode. 
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9.4 Display of GPIOs and control of GPOs 
Click on the  icon to access the view that displays the state of the card's GPIO, from which the 
GPO can be activated/deactivated. 

 

From the bottom bar of the GPIOs view, select the ALP card to display the status of its GPIOs. 

The status of the GPIs is displayed on the left, and the state of the GPO is displayed on the right. 

To position the state of a GPO manually, click on the "STATE" switch matching this GPO to move it to 
the desired position: Open or Close. 

 

 

9.5 Creating, saving and loading sessions 
The current configuration of all settings defined in ALP-X Manager can be saved. Go to the File menu 
and select "Save session as". 

To load a settings configuration, go to the File menu and select "Open session".  

To create a new configuration from blank settings, go to the File menu and select "New session".  

To save the settings during an existing session, go to the File menu and select "Save".  

 

 

 

9.6 Firmware update procedure 
The ALP card on-board firmware may have to be upgraded, and updates can be supplied by 
Digigram and prove necessary. 
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To perform an update, click on the button  on the right of the “Firmware version” field, as 
shown on the screen capture below. 

 

 

 

The ALP card is selected from the list of cards detected. 

Click on the "Browse" button and select the file matching the new 
firmware to be applied (file with extension “.bin”). 

 

 

Click on the "Update" button to launch the update. 

 

 

The firmware upload is in progress 

 

Once the upload is completed, it is necessary to shut down the 
computer. Select “Shut down now”  for an immediate automatic 
shutdown, or “Shut down later” if you want to shut down the 
computer later.  In this latter case, don’t forget to shut down and 
restart the computer before using the card. 

 

Select “Yes” to confirm the shut down, or “No, I will shut down 
later”. In this latter case, don’t forget to shut down and restart 
the computer before using the card. 
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9.7 Keyboard shortcuts 
 

Keyboard shortcut Action  

Session 

Ctrl + S Save 

Ctrl + Alt + S Save As 

Ctrl + N New 

Ctrl + O Open 

Potentiometer/Fader 

Ctrl + Wheel  1 dB increments on the potentiometer/fader 

Ctrl + Shift + Wheel  0.1 dB increments on the fader​
0.5 dB increments on the potentiometer 

Double click Reset the fader/potentiometer value to 0 

Matrix 

Ctrl + Wheel  1 dB increments on the mixing point 

Ctrl + Shift + Wheel  0.1 dB increments on the mixing point 
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10 ASIO CONTROL PANEL for Windows 
The ASIO control panel can be started from the Asio application, from the menu allowing for the 
settings of the audio device and the ASIO configuration.​

 

 

Active cards group 

 

This section allows selecting one ALP card to be used under ASIO, or all the 
ALP cards (multi-card ASIO feature). 

In case the option “All ALP boards” is selected, all the ALP cards must be 
interconnected via the Wordclock. From the ALP-X Manager application, the 
first card clock can be internal or external, and its wordclock output must 
be connected to the wordclock input of the second board. The clock source 
of the 2nd board must be set to Wordclock, and its wordclock output must 
be connected to the wordclock input of the 3rd board, and so on until the 
last ALP card. The 1st card can be any of the installed cards. 

Asio channels allocation This section is used to select the input and output channels that are 
managed by the ASIO driver and which can therefore be used by any 
application based on the ASIO interface. 

For the card or the Group of cards selected from the “ACTIVE CARDS 
GROUP” list, click on the "ASIO CHANNELS ALLOCATION" button and select 
the channels to be used under ASIO.​

​
In case only some channels have to be used, uncheck “All channels”, and 

select the required channels. Click on  to save the settings. 
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A card that is not used under ASIO can be used from a WASAPI or 
DirectSound application. 

 

Buffer size (latency) 

This section is used to select the size of audio buffers used by the ASIO 
driver. This size is given as a number of samples and a cross-reference in 
duration is indicated for a sampling frequency of 48 kHz. The higher the 
buffer size, the higher the latency. 

The buffer size is from 24 samples to 8192 samples. However it must be at 
least equal to the number of internal playback buffers minus one, 
multiplied by the internal buffer size (internal buffer size and number of 
playback buffer size being set from the Windows device manager, card 
properties tab). 

Example: 

 

●​Internal buffer size = 64 
●​Number of playback buffers=3​

 
=> Minimum size of ASIO buffers:​
(3-1)*64=128 samples. 

A small ASIO buffer size can lead to breaks in audio throughput on a low-powered 
machine or on a machine with a high processor load. 

 

Sample size 

This setting defines the format of samples exchanged between the 
application and the card driver.  

 
Enable Direct Monitoring Control 

Tick this setting to authorise an ASIO application to drive the zero latency 
hardware monitoring of inputs towards outputs. If an application monitors 
software, this causes latency between the input signal and the output 
signal, linked to the ASIO buffer sizes. 

Boost ASIO priority​
This option allows the system to run the ASIO process with high priority, 
thereby increasing the reliability of this process. Caution, however, this 
can make other processes unstable. 

 

Audio errors 

This section is used to visualise current errors for playback and recording 
via the ASIO driver. Errors frequently reflect too small an ASIO buffer size 
for the system's possibilities. Should they occur, then the buffer size needs 
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 to be increased until there are no more errors. 

Sync status errors reflect clock synchro errors (AES11 external clock, 
WordClock or inter-card synchro). 

Error counters can be reset to zero by clicking on the RESET button. 

Lastly, a time counter displays the time elapsed since the last counter 
reset. 
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11 LOADING THE ASIO DRIVER FROM A 
SERVICE 
When the ALP-X ASIO driver is loaded by a service owned by the SYSTEM user, the ALP-X Asio 
Settings software must be started externally from an administrator-level command. 

●​ First run the service and initialize the ASIO driver, in order to generate the registry key. 
●​ Using regedit, find the generated key in HKEY_LOCAL_MACHINE\SOFTWARE\ASIO\ASIO 

ALP-X\[application MD5 key]​
There may be several MD5 keys under the "ASIO ALP-X" level. In this case just check the 
"ApplicationName" value under each key. 

●​ If the service is a 32-bit application, the registry path does not use a MD5 hash, and contains the 
"WOW6432Node" level :​
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ASIO\ASIO ALP-X\[application path] 

●​ Then run AsioSettings.exe from an administrator console :​
> cd "\Program Files\Digigram\ALP-X\ALP-X ASIO Settings"​
If the service is a 32 bits application :​
>AsioSettings.exe --asioRegPath "HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ASIO\ASIO ALP-X\[application path]"​
If the service is a 64 bits application :​
> AsioSettings.exe --asioRegPath "HKEY_LOCAL_MACHINE\SOFTWARE\ASIO\ASIO ALP-X\[application MD5 key] " 
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15 SPECIFICATIONS 

15.1 Configuration 
Bus/Format PCI EXPRESSTM  x1 / Low profile​

(compatible x4, x8, x16) 

Dimensions 168 mm × 69 mm x 20 mm 

Consumption (+3.3 V/+12 V) 1 A/0.35 A 

In operation: temperature/humidity​
(without condensation) 0°C/+50°C • 5%/90% 

Storage: ​
temperature/humidity​
(without condensation)  

-5°C/+70°C • 0%/95% 

 

15.2 Inputs 
 ALP280e ALP280e-Mic 

Analog inputs  8 balanced line 8 balanced Mic/line 

Maximum input 
level / impedance 

+24 dBu / >10 kΩ 
 

Line: +24 dBu / >10 kΩ 
Mic : +10 dBu /> 10 kΩ 

Line input gains -24 dB to +16 dB, in 0.5 dB steps​
Max. sensitivity: 0 dBfs for -16 dBu  

Mic input gains - 0 dB to +56 dB, in 0.5 dB steps​
Max. sensitivity: 0 dBfs for -56 dBu 

Digital input gains -90 dB to +12 dB, 0.1 dB increments 

Synchronisation 
inputs  

1 AES11, 32 kHz to 192 Khz 
1 Word Clock, (75 Ohms), 32 kHz to 192 Khz 

GPIs 8 dry contacts 

 

15.3 Outputs 
 ALP280e & ALP280e-Mic 

Line level analog outputs  2 electronically balanced ​
(can be used asymmetrically without loss of level) 

Maximum output level / impedance +24 dBu / <100 kΩ 

Programmable digital output gain -90 dB to +12 dB, 0.1 dB increments 

Clock output 1 Word Clock, (75 Ohms), 32 kHz to 192 Khz 

Contacts 8 relay contacts, 0.5 A, 48 VDC 

36 



 
User Manual for ALP280e & ALP280e-MIC 

15.4 Audio characteristics 

Sampling frequency Programmable from 8 to 192 kHz 

CAN/CNA resolutions 24 bits/192 kHz 

Audio formats supported PCM: 16, 24, 32 bits, Float IEEE754 

 

15.5 Analog performances 
Measurements taken at Fs=48 kHz, with filter on band 22 Hz-22 kHz. 

Frequency response  @48 kHz, 20 Hz - 20 kHz - Inputs: +/- 0.83 dB Outputs: +/- 0.57 dB 
@48 kHz, 10 Hz - 20 kHz - Inputs: +/- 2.72 dB Outputs: +/- 0.57 dB 

Phase shift between tracks  
@10 Hz: Inputs: < 0.81°  / Outputs: < -0.24°  
@1 kHz: Inputs: < 0.01°  / Outputs: < -0.02°  
@20 kHz: Inputs: < 0.14°  / Outputs: < -0.13°  

Signal to Noise Ratio Inputs: >115 dBA (>112 dB unweighted) ​
Outputs: >109 dBA (>106 dB unweighted) 

THD + Noise 
@1 kHz 
+24 dBu : Inputs: <-95dB / Outputs: <-94 dB  
+22 dBu : Inputs: <-98dB / Outputs: <-96 dB   

Crosstalk ​
 

Inputs: -128 dB @1 kHz / -107 dB @15 kHz /  -105 dB @20 kHz​
Outputs: -127 dB @1 kHz / -112 dB @15 kHz / -108.5 dB @20 kHz 

Equivalent Input Noise 
(E.I.N) (ALP882e-MIC) 

-124 dB (A/D-D/A, G=+56 dB) 
 

 

15.7 Connectors 

Internal connectors Inter-card synchronisation 

External connectors 2 x 68-pin VHDCI connectors 
One for analog I/Os​
One for Digital I/Os (Clocks + GPIOs) 

 

15.8 Development environment 

Drivers DirectSound/WASAPI, ASIO 

Operating systems supported Windows 10 from version 20H2,  Enterprise version  LTSC 
1607 

Main characteristics of on-board 
processing 

PCM playback and acquisition, Float IEEE754, direct 
monitoring, real time mixing, levels adjustment, panning 
management 
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16 APPENDICES 
16.2 ALP280e & ALP280e-MIC functional diagram 

 

 

Note: 48V phantom power only for ALP280e-MIC 
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16.3 LED 
The ALP card has four green LEDs: 2 LEDs on the PCB (only visible when the PC is open) and two LEDs 
on the bracket as illustrated in the diagram below. 

 

 

LED Description Behaviour 

LED 1  Signals when the card is initialised correctly Constantly lit  

LED 2  Signals if the card is running the last updated 
firmware or the backup factory firmware 
version. 

●​ Flashes every 2 seconds:​
The card runs the last uploaded firmware version 
(normal behaviour). 

●​ Flashes every second:​
The card runs the backup factory firmware instead 
of  the last uploaded version This last firmware is 
corrupted in memory and has to be  applied again. 

WC In Wordclock ●​ Off when no Wordclock signal is detected. 
●​ Flashes when a Wordclock signal is detected but the 

card is not synchronised on it 
●​ Lit when the card is synchronised to the Wordclock 

input 

InterCard 
sync 

Intercard synchro / card locator ●​ Off when the card is not synchronised to another 
one via the inter card ribbon cable 

●​ Lit when the card is slaved to another one via the 
intercard synchro ribbon. 

●​ Flashes when the button “card locator” is pressed 
from the ALP-X Manager application. 
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16.4 Connectors and switches 

 

J1: Connector for analog I/Os​
VHDCI 68 pins, female 

J2: Connector for digital I/Os​
VHDCI 68 pins, female.  

J3: Connector for  inter-card synchronisation 

 

16.5 How to use the GPIOs 

16.5.1 GPIs 
The eight GPIs are dry contacts,  as shown on the diagram below.  It is not necessary to connect a 
voltage to the GPIs. 
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​
When the GPI pin is not connected to the ground, the GPI status is OPEN.​
When the GPI X pin is connected to the ground, the GPI status is CLOSED. 

 

16.5.2 GPOs 
The eight GPOs are opti-relays, as shown on the diagram below.  

 

The contact between GPO_COM and GPO-NO is made when the CLOSED command is sent. ​
GPOs support a maximal voltage of 48VDC and a maximum current of 500 mA. 
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16.7 Breakout cables 

16.7.1 Cable for analog I/Os  
16.7.1.1 Diagram 
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16.7.1.2 Pinout 

 
 

J1 Upper VHDCI 68 pins male 

J2 ,  J3 Female XLR: analog inputs 

J10 to J17 Male XLR: analog outputs 

 

 

Pinout of connector J1 (VHDCI male) 
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Pin# Signal Pin #  Signal Pin # Signal 

1 GND 24 - 47 GND 

2 GND 25 GND 48 GND 

3 ANA IN8 - 26 GND 49 ANA IN4 - 

4 ANA IN8 + 27 - 50 ANA IN4 + 

5 GND 28 - 51 GND 

6 GND 29 GND 52 GND 

7 ANA IN7 - 30 GND 53 - 

8 ANA IN7 + 31 - 54 - 

9 GND 32 - 55 GND 

10 GND 33 GND 56 GND 

11 ANA IN6 - 34 GND 57 - 

12 ANA IN6 + 35 GND 58 - 

13 GND 36 GND 59 GND 

14 GND 37 ANA IN1 - 60 GND 

15 ANA IN5 - 38 ANA IN1 + 61 ANA OUT2 + 

16 ANA IN5 + 39 GND 62 ANA OUT2 - 

17 GND 40 GND 63 GND 

18 GND 41 ANA IN2 - 64 GND 

19 - 42 ANA IN2 + 65 ANA OUT1 + 

20 - 43 GND 66 ANA OUT1 - 

21 GND 44 GND 67 GND 

22 GND 45 ANA IN3 - 68 GND 

23 ANA OUT7 - 46 ANA IN3 + - - 

16.7.2 Cable for digital I/Os  

16.7.2.1 Diagram 
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16.7.2.2 Pinout 
 

​
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J1 connector (lower VHDCI male)   

Pin# Signal Pin # Signal Pin # Signal Pin # Signal 

1 WLCK OUT 18 GPO1-COM 35 WLCK IN 52 GPI 1 

2 GND 19 GPO1-NO 36 GND 53 GND 

3 GND 20 GPO2-COM 37 AES11-SYNC IN- 54 GPI 2 

4 - 21 GPO2-NO 38 AES11-SYNC IN+ 55 GND 

5 - 22 GPO3-COM 39 GND 56 GPI 3 

6 - 23 GPO3-NO 40 - 57 GND 

7 - 24 GPO4-COM 41 - 58 GPI 4 

8 GND 25 GPO4-NO 42 GND 59 GND 

9 - 26 GPO5-COM 43 - 60 GPI 5 

10 - 27 GPO5-NO 44 - 61 GND 

11 GND 28 GPO6-COM 45 GND 62 GPI 6 

12 - 29 GPO6-NO 46 - 63 GND 

13 - 30 GPO7-COM 47 - 64 GPI 7 

14 GND 31 GPO7-NO 48 GND 65 GND 

15 - 32 GPO8-COM 49 - 66 GPI 8 

16 - 33 GPO8-NO 50 - 67 GND 

17 GND 34 GND 51 GND 68 GND 

 

J13 (Sub-DB25 female) - GPIs 

 

J14 (Sub-DB25 female) -  GPOs 

Pin# Signal Pin# Signal Pin# Signal Pin# Signal 

1 GPI 1 14 GPI5 1 GPO1 COM 14 GPO5 COM 

2 GND 15 GND 2 GPO1  NO 15 GPO5  NO 

3 GND 17 GPI6 4 GPO2 COM 17 GPO6 COM 

4 GPI 2 18 GND 5 GPO2 NO 18 GPO6 NO 

5 GND 20 GPI7 7 GPO3 COM 20 GPO7 COM 

6 GND 21 GND 8 GPO3 NO 21 GPO7 NO 

7 GPI3 23 GPI8 7 GND 23 GPO8 COM 

8 GND 24 GND 10 GPO4 COM 24 GPO8 NO 

10 GPI4 25 GND 11 GPO4 NO 25 GND 
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Please contact your distributor for all technical support issues 

​
​

​
 

Digigram Digital 
82 Allée Galilée, 38330 Montbonnot - FRANCE 

Tel: +33 (0)4 76 52 47 47  
E-mail: info@digigram.com 

 

Digigram Asia Pte Ltd. 
60 Albert Street - #09-11 OG Albert Complex Singapore 189969, Singapore 

 Tel.: +65 6291 2234 • Fax: +65 6291 3433  
E-mail: info_asia@digigram.com 

​
​
​
​
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